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Photoshop & Lightroom Updates
In this lesson, we’re going to learn about all of the new features that Adobe has incorpo-
rated into Lightroom and Photoshop over the past year.   

Lightroom

Apply Auto Develop on Import (2:04) In the past, Lightroom gave you the option to 
apply the Auto settings to your images upon import. This is the setting that you’re used 
to seeing in the Basic panel of the Develop Module. When you apply this setting, Light-
room will automatically adjust the toning sliders in a way that it thinks will optimize 
your image. This Auto setting used to be available in the Import Dialog, but Adobe has 
recently removed it.

If you liked using this Auto setting on im-
port, there is a way to still access it (in a 
way). In the Develop module, create a new 
develop preset by clicking on the little plus 
symbol (+) at the top of the Develop Pre-
sets panel on the left side of the interface.  
The New Develop Preset dialog box will 
appear. First, click the “Check none” but-
ton at the bottom, then turn on the Auto 
Tone Checkbox. I also named this preset 
“Auto Tone Only.” Click Create. This preset 
will be the equivalent of clicking the Auto 
Button. Now, when you import images, you 
can look to the right side of the interface 
to the area called “Apply During Import.” 
This is where you can choose a preset that 
will applied to be all images as they’re im-
ported. If you choose that Auto preset you 
just created, it will do the same thing as the 
old Auto setting. 

Remember that after importing images, Lightroom will remember the import settings 
you used last, so you would have to change this if you didn’t want it applied to your next 
set of imported images.

To create a preset that applies the Auto Set-
tings, turn off all settings except for the Auto 
Tone check box in the New Develop Preset 
dialog. 
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Reference view (7:11) In the Develop Module, there is a new 
view that you can use to view a reference image on the side 
while you simultaneously work on your active image. This 
can be useful for when you want to give an image a similar 
look, or style, to an image you have already finished. The 
view is called Reference View and you can access it by click-
ing its button in the lower left corner of the image window. Alternatively, you can use the 
keyboard shortcut Shift+R. (Use the D key to return to Default view) When you  use Ref-

erence view, the left side of your screen 
will be marked Reference and the right 
side is called Active. Simply drag an im-
age from the filmstrip into the Reference 
View window. If you leave the Develop 
Module and then return to it, Lightroom 
will not automatically remember which 
reference image you were using, so the 
Reference View will be empty again. If 
you would like Lightroom to remember 
the image you last used, click on the lit-
tle Reference Photo lock icon at the bot-
tom of the image window. 

When you access Reference View, Lightroom will show you the two images side by side. 
If, instead, you would like to view them one on top of the other (better for viewing pan-
oramas), then simply click on the Reference view icon again. Clicking the Reference view 
icon will toggle between a side-by-side view and a stacked view.

In the Library Module, you can right-click on an image to get a pop-up menu of settings, 
one of which is “Set as Reference Photo.” If you choose this option, the next time you go 
to the Reference View in the Develop Module, that image will automatically be placed 
as the reference photo. In that same pop-up menu, there is also an option to “Open in 
Reference View” and this will move you to the Develop Module with the selected image 
as the Active photo in Reference View. 

If both your active photo and your reference photo have the same aspect ratio, two sets 
of numbers will appear for the RGB values in the histogram: one set for each image. 

The icon to activate  
Reference View.

Above: Reference View. 
Left: The icon to lock 
the Reference Photo. 
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Panorama Features (15:22) Lightroom has a built-in feature for merging panoramas, 
and it recently got some added features. If you select two or more images in Lightroom, 
you can access the Panorama Merge feature by going to the main menu and choosing 
Photo > Photomerge > Panorama. Inside the Panorama Merge window, there is now an 
“Auto Crop“ check box, which will automatically crop out any extra white area caused 
by the photo merge. There is also a Boundary Warp slider, and dragging it up will make 
the cropping looser and looser, bending the photo in the areas on the edge to try and 
fit more of the edge area inside the cropped frame. You have to be careful when using 
the Boundary Warp slider as it can cause noticeable distortion in areas that have a good 
amount of detail. Note that you will also find the same features (Auto Crop and Bound-
ary Warp) in Photoshop when you merge a panorama using Adobe Camera Raw.  

Above: The Auto-Crop and Boundary 
Warp settings are new inside the Panora-
ma Photomerge dialog. The Auto-Crop 
setting is turned on in this screen shot. 
Left: The Auto-Crop setting is turned 
off, leaving the white space around the 
edges. 
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Filter by Snapshot Status (18:29) In the Library Module, you have access to a very pow-
erful tool called the Filter Bar, which is located above the main image window. Using 
the settings in this bar, you can use the specific filters to narrow down and search out 
images. There is now a new search parameter available in the Filter Bar which allows you 
to search your images based on Snapshot Status. Snapshots allow you to save different 
states of your image, with different adjustment slider settings, and you would create 
Snapshots in the Develop Module. One of the things I use Snap Shots for is showing a 
progression of how I fine-tuned an image. 

The Snapshot filter can also be used 
when creating a new Smart Collec-
tion, which is essentially a saved 
search in the form of a collection of 
images. To create a Smart Collec-
tion, click on the plus symbol (+) at 
the top of the Collections panel and 
choose “Create Smart Collection.” 
A dialog box will appear where you 
can choose which search parame-
ters Lightroom will use to populate 
the collection. One of those choic-
es is now “Has Snapshots” and you 
can choose whether this parameter 
should be true (has Snapshots) or 
false. 

The Filter Bar is shown above and you can see that we have used the Snapshot Status search 
parameter to see which of my images have Snapshots. 

The dialog to create a new Smart Collection is 
shown above and you can see that the “Has  
Snapshots” search parameter has been used to  
create the Smart Collection. 
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Export Collection Set as a Catalog (21:42) A collection is a virtual folder for your imag-
es. It’s similar to a playlist of music in that Lightroom knows where the individual photos 
are, but it wont move them on your hard drive. A Collection Set is in essence a folder 

that can contain Collections. Collection 
Sets can be created by clicking the plus 
icon at the top of the Collections panel 
and choosing “Create Collection Set.”

Now, there is a new feature in Lightroom 
that allows you to export a Collection Set 
as its own, separate catalog. If you right-
click on the name of a Collection Set, 
you’ll get a pop-up menu that will now 
give you the option to “Export Collection 
Set as a Catalog.” When you choose this, 
you’ll get a brand new catalog file that 
will contain only that which is contained 
in the chosen Collection Set. 

Backups are now compressed files (23:44) When you create backups of your Light-
room catalogs, they can potentially take up a lot of room on your hard drive, depending 
on how large the catalog is. Now, Lightroom will automatically compress large catalog 
files when you perform the backup. Note that when this happens, you may get a warn-
ing dialog and that is because the Mac OS is not good at expanding zipped files over 4 
GB. In order to expand a zipped file of this size, you may have to download a free utility. 
I would recommend StuffIt Expander for this task. 

Low res images will scale to fit screen (25:44) In the past, if you had a low res graphic  
or photo and you clicked to view the image in full screen, Lightroom would only show 
you the image in its actual size, which would likely be very small. Now, if you click to view 
an image in full screen, Lightroom will actually scale it up to fit the screen.

Edit using Smart Previews (26:56) If you go to your preferences, there is a new check 
box under the Performance tab called “Use Smart Previews instead of Originals for Im-
age Editing.” A Smart Preview is kind of a miniature raw file of your original image. It is 
convenient because it takes up less space on your hard drive yet allows you to edit the 
image while the hard drive containing it is not connected to your computer. Turning on 

You now have the option of exporting a Col-
lection Set as its own, separate catalog. Access 
this menu by right-clicking on the name of the 
Collection Set. 
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this setting will tell Lightroom to use the Smart Preview when you edit your image re-
gardless of whether the hard drive containing it is connected or not. The benefit to this 
would be that because the file size is smaller, things will load much faster. What’s great 
is that if the original image file is accessible, Lightroom will automatically switch to using 
it when you zoom in on the photo. 

On a similar note, Lightroom will now give you the option of using Smart Previews to 
merge panoramas and HDR images. The resulting file size will be smaller than if you 
used the original files, but you still have the option to merge the lower resolution images. 

New export features (33:35) Now, you can export your images (those with Smart Pre-
views) even when the drive containing them isn’t connected. When doing this, I would 
only recommend exporting to a size that is equal to or smaller than the Smart Preview 
size. In the Export dialog box, there is an area called File Settings, and this is where you 
can choose which color space to use. A new color space is now available and it’s called 
Display P3. This is because some of Apple’s newer devices can display colors more viv-
idly and this color space will allow you to make the most of that. 

Photoshop
What’s missing (37:29) It used to be that one of the workspaces available in the Pho-
toshop interface was the Design Space. This was basically just a simplified workspace, 
and it is no longer available. Also, Photoshop no longer supports very old versions of the 
Mac OS, so if you are running one of these operating systems, you wouldn’t be able to 
update Photoshop. This is not a big deal unless you have a really old machine. 

New Find Feature (38:39) In the past, if you used the 
keyboard shortcut, Command+F (Ctrl+F on Win), it 
would apply the last filter you used. Now, when you 
type Command+F, Photoshop will bring up a “Find” 
dialog. When you type something into the search field, 
it will search Photoshop’s interface for any feature it 
thinks you’re searching for. At the bottom, it search-
es Adobe’s website for the term and below that, the 
Adobe Stock site (for stock photography). At the top 
of the results, you can choose whether you want to 
see all results or just those related to Photoshop’s in-
terface, Adobe’s website or the Adobe Stock site. 

The new Find dialog box
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Auto-Select on by default (43:07) When you use 
the Move Tool, there is an Auto-Select check box 
in the Options Bar. When this is turned off, you can 
click and drag anywhere in your document and you 
will only be moving the content of the active layer. 
If you turn the check box on, it will move whatever 
is directly beneath your cursor, regardless of which 
layer it’s on.  In the past, this check box was turned off by default. Now, it’s turned on by 
default. If you don’t like it, you’ll have to click the check box to turn it off. Note that you 
can temporarily activate the Auto-Select feature by holding down the Command Key 
(Ctrl on Win) while using the Move Tool. 

New “Start” Workspace (46:35) When you open Photoshop (or when Photoshop is 
running with no documents open), you will now see a Start Screen. On the left of the 
screen, you’ll have options to create a new document or open and existing document. 
In the main area, you will get a thumbnail list of your most recently accessed images. 
Below that area, you can search for Adobe Stock Images. 

If you don’t want your recent files to appear in this window, you can go to the File menu 
and choose Open Recent > Clear Recent File List. If you don’t want to view this Start 
Workspace, click on the Workspace icon in the top right of your screen and choose a 
different workspace. If you want to get it back, switch back to the “Start” workspace.

By default, this Start workspace will appear when there are no documents open. If you 
don’t want this, go to your Preferences and under “General,” turn off the check box that 
says “Show Start Workspace when no Documents are open.”

The Auto-Select check box can be 
found in the Options Bar when the 
Move Tool is active. 

The new Start  
Workspace



Video 20 | Photoshop & Lightroom Updates  © Ben Willmore, All rights reserved 9

New Document Dialog (49:19) Adobe has re-
cently changed the dialog box that appears 
when you choose to create a new document. 
Now, the box is larger and more visual. At the 
top, you will find different types of document 
presets (Photo, Print, Web, etc.) as well as 
a category called “Saved” in which you can 
save your own presets. To create a saved pre-
set, use the document settings on the right to 
specify dimensions, resolution, etc. and then 
click on the New icon to the right of the preset name. To delete a preset, click on the 
trash can icon in the upper right of the preset thumbnail. 

When looking through the different preset categories, you will also find a list of tem-
plates beneath the list of presets. These templates are coming from Adobe’s website 
and most of them are free for you to use. To use one, click on the template to get a larger 
preview and then click the Download button in the lower right corner of the dialog box.  
Once it’s done downloading, the button will say “Open” and you can click on it to open 
the template document. When you open a template, the Layers Panel will be set up in a 
way that makes it easy to insert your own images into existing Smart Objects. 

The New Document dialog box

We opened a template from the New Document dialog and placed an image into it. 
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After you’ve used a template, it will appear in the “Recent” section of the New Docu-
ment dialog box. If you don’t want it to appear in this area any more, you will need to 
remove it from the Stock Templates Library within the Libraries Panel. 

If you don’t like the new “New Document” dialog at all, you can revert to the old dialog 
by going to your Preferences, clicking on the General tab and turning on the checkbox 
that says “Use Legacy New Document Interface.” 

Touch Bar Support (1:01:14) If you have a new MacBook Pro that has the touch bar 
above the keyboard, know that Photoshop has now added support for this feature. You 
will need to specify on the Mac OS that you want the touch strip to display Photoshop 
controls and you can do that within the System Preferences for the operating system. 
Click on the Keyboard settings and then switch the “Touch Bar Shows” dropdown to 
either “App Controls with Control Strip” or “App Controls.” The “App Controls with Con-
trol Strip” setting will show controls for the current app (in our case, Photoshop) on the 
left and settings for your mac on the right. The “App Controls” setting will just show you 
settings related to the active app. The “Expanded Control Strip” option will give you 
settings for your Mac only. 

When you are working in Photoshop and have the Control Strip set to show app settings, 
you can switch between what kind of settings appear there. The icon on the far left will 
tell you what kind of settings are being displayed. The icon that looks like three little 
adjustment slider indicates that you are seeing settings related to your layer properties. 
The brush icon means that you’re viewing brush settings and the star icon indicates that 
you are viewing settings related to your favorites. You can switch between the three 
views by tapping the icon. When it comes to the Favorites view, you can specify what 
settings appear there by going to the View menu and choosing “Customize Touch Bar.”

The three different options for what to show in the MacBook Pro touch bar. 

The three different kinds of Photoshop settings you can view in the touch bar. 
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Pen Pressure Support (1:07:19) If you’re in Camera Raw and you have a pressure-sensi-
tive tablet, the Flow setting in the Adjustment Brush will now be affected by the pres-
sure of your pen. Also, if you flip the pen upside down, it will act as an eraser. 

Content-Aware Fill in the Crop Tool (1:08:06) With the Crop Tool active, there is now a 
check box called “Content Aware” in the Options Bar. If this check box is turned off, the 
crop box will be restrained to the edges of your image, so if you rotate the crop box, the 
corner areas will be cut off. If you turn the check box on, you will be able to extend the 
crop box beyond the edges of the image and when you hit enter, Photoshop will use the 
content-aware fill command to fill in any empty areas.

If you find that the Content-Aware check box does not appear when you have the Crop 
Tool active, there is one setting to check. In the Options Bar, click on the little gear icon 
and a dropdown menu will appear. If you have the “Use Classic Mode” setting turned on, 
this could cause the Content-Aware check box to go away.

Updates to Liquify Filter (1:11:58) There are a couple of new features within the Liquify 
filter, which you can access by going to the main menu and choosing Filter > Liquify. In 
the Liquify window, there is now a Preview check box so you can see a before and after 
view of your work. In the Face-Aware Liquify area, it used to be that any changes you 
made to the eyes affected both eyes equally. Now, you have individual settings for each 
eye, with the option to lock the left and right together so that the changes affect both. 

Far left: The Crop Tool is 
active and we are rotat-
ing the crop box. You can 
see that the crop box ex-
tends beyond the image. 
Directly left: We hit Enter 
and Photoshop filled in 
the areas with empty 
canvas area. 
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View Layer Count (1:14:23) If you have a 
multi-layered document, you can click on 
the info display on the bottom left side of 
the interface and in the pop-up menu of 
display choices, you now have the option 
to view a layer count. This can be useful 
if you commonly create documents with 
loads and loads of layers. 

Layer Properties (1:15:14) Now, if you 
click to view the Properties Panel when 
you have a layer active, it will show the di-
mensions and position of that active layer. 
You can use the fields provided to type 
in values to change the size and position. 
Note that if you’re viewing the properties 
of the background layer, the size fields 
will be grayed out and that’s because the 
background layer is locked by default. If 
you would like to scale the layer, you’ll just 
have to unlock it, and you can do so by 
double-clicking on the layer in the Lay-
ers Panel. If you click on a Type layer, the 
Properties panel will display many of the settings available in the Options Bar. To see 
the Type Tool settings in the Options Bar, the Type Tool actually has to be active. In the 
Properties panel, the Type Tool does not have to be active in order for you to see and 
adjust the settings pertaining to the Type layer. 

SVG Fonts (1:19:09) When you are chang-
ing or choosing a type face, you will notice 
a few different colored typefaces available in 
the menu and these are called Scalable Vec-
tor Graphic Fonts. Trajan Color is an example 
of this. These fonts are made out of vectors 
but can have multi-colored shading. When 
you use one of these fonts, the Glyphs panel 

Clicking on the info readout will now give the 
option of viewing your Layer Count. 

The Properties panel will now display the 
dimensions and position of the active layer. 

The Glyphs panel will appear when you 
use an SVG font. 
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will appear, from which you can choose a 
different color. Alternatively, you can high-
light a letter or letters that are being dis-
played in an SVG font. When you do this, 
a pop-up menu will appear that gives you 
different color options for the highlighted 
type.  

Another way of changing the color would 
be to first exit out of the Type Tool and then 
click the fx icon at the bottom of the Lay-
ers panel to access the Layer Styles menu 
and choose Color Overlay. In the dialog box 
that appears, set the Blending Mode to the 
Hue or Color and then use the color picker 
to choose the color you want. 

Emoji fonts (1:23:59) Another new kind of type-
face is the Emoji “fonts.” When you choose this, 
the Emojis Glyphs Panel opens that displays all of 
the available emojis, which are all scalable vector 
graphics. Note that you don’t use this to change 
already-existing text. Instead, you double-click 
on the different emojis in the menu to add them 
to your type layer. 

Copy SVG graphics (1:26:06) If you have a graphic you created, you can now copy it as 
an SVG (Scalable Vector Graphic) to paste into other programs. With the Move Tool ac-
tive, right click on the layer and choose Copy SVG from the pop-up menu that appears. 
You can then paste the graphic into other programs that support the SVG format. 

Select & Mask (1:27:14) There are a few new features in the Select and Mask feature, 
which can be accessed by going to the main menu and choosing Select > Select and 
Mask. In the Select and Mask window, there are now a couple of new tools available on 
the left side of the interface and these include the Lasso Tool and the Polygonal Lasso 
Tool. You can use these to fine-tune your selection and they work the same way that 
they would in the main Photoshop interface. 

Highlighting text in an SVG font and then 
hovering over the letters will give you a  
pop-up menu of color choices.

Some of the Emojis available, as seen 
in the Glyphs panel. 


